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1 Requirements
This guide is for programming a system using the Rasoft Pro software which is available for
download at http://www.rakocontrols.com/support/software.

Programming the system will require a communication Device to be connected: either a
RAMPI, HUB, or Bridge Module to a Windows or Mac computer. It may also be useful to
have a full list of the Rooms and circuits that will be included in the project so these can be
entered when using the new project wizard.

2 Create a new Rasoft Pro Project File
All projects in Rasoft Pro require a file to be created, to create a new project file:

- Open Rasoft Pro

- Select “File” > “New Project” to bring up the new project wizard.

2.1 Project name and House numbers

- Choose a suitable project name, typically the name of the property.

- Choose a House Number, typically the House Number of the property, and select
‘Next’.
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IMPORTANT
Every Rako system must be assigned a House number. Rasoft Pro will suggest a House
number based on previous projects by default; a custom House number can be selected if
preferable. Do not use House 1.

2.2 Save Locations

Select the Save Location for the project file. It is best to use the default save location
(C:/Users/[user]/Rako) for Windows or (Macintosh HD/Users/[user]/Rako) for MacOS.

Files saved at this location will appear in recent projects on the Rasoft Pro home screen
when re-opened.

2.3 Adding Rooms

The next step of the Setup Wizard requires adding the Rooms, additional Rooms can be
added later if required, this step can also be skipped entirely if the Room names are not yet
known.

- Using the text field, give the Room a name.

- Select the ‘Room Type’.

- Select ‘Add’.

- Repeat the previous steps for each Room required.

Wireless Module Setup Guide Version 3.5.0



Once a Room has been added, it will appear under the Room list heading with an
automatically assigned Room number. Continue adding until the box on the right-hand side
is populated with all the Rooms in the property. Rooms can be deleted anytime by
highlighting them and clicking “Delete Selected.”

Adding Rooms for group features:

Although in most cases, the automatically assigned Room numbers are adequate,
sometimes manually selecting Room numbers may be preferable. This will mainly be
necessary when “Group” features are being used (see Appendix 3).

Do not use Room 255, as this is occupied by the RxLINK.

There are two methods of setting a custom Room number. For a new Room in an existing
project select “File” – “New Room” to bring up this menu:
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Un-check the “Auto-Room” box and enter the desired Room number.

Alternatively, an existing Room number can be changed from the “Room Editor” tab. Select
ID and change the value:

It is best to do this before any Devices are assigned to this Room. If circuits are already
mapped to the RxLINK you will be prompted in the software:
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Select “Yes” to both options. These will change the Room numbers in the mappings page
for the RxLINK to the new Room numbers. The mappings will have to be uploaded again
once these changes have been made.

NB
If Wireless modules are addressed to a Room with a changed number, they will all have to
be re-addressed as if they were new.

2.4 Adding Channels

In the “Add Channels” screen, all the added Rooms will appear along the top. Each column
below the Room name lists the Channels within that Room.

NB
A Channel is usually the same as a circuit of lights, although it may sometimes be desirable
to have two or more circuits as one Channel if they are always to dim together.

Type the name of the circuits into the column associated with each Room to populate the
Channels. Like Rooms, new Channels can be added, altered, or deleted later.
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2.5 Adding Devices

It is generally advisable to only use the Add Devices step when preparing the project file
off-site. When programming on-site it is usually easier to add Devices one by one as they
are addressed into the system.

The Devices to be programmed can be added using this page, for a wireless RAK system,
this will usually just be RxLINKs. Select the number of RxLINKs in the system and click Add.
Adding Devices using this page will create them as “virtual Devices” in the Device Editor
once the project has been generated.

It is not essential to add the RxLINKs at this stage. They can be added one by one later if
this is preferred. If this is the case, then just leave this screen blank and press "next.”

If a HUB/Bridge is being used to programme the system, add it in the same way. If a RAMPI
is being used, it does not need to be added as a Device.

2.6 Selecting a Level

There are two user Levels available in Rasoft Pro. In general, the normal Level should be
used; this will give full access to all menus while still providing help options if required.

The expert mode allows access to all debug menus, which are only required when
programming a wired system.

2.7 Connecting to a Communication Device
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Before starting to assign circuits to Channels, the computer must be connected to a
communication Device, which can be either a HUB/Bridge or RAMPI. When a
communication Device can be found by Rasoft Pro, it will appear in the communications
window on the bottom right of the screen. For information on how to connect to a
communication Device, see Appendix 1.

3 Addressing modules
Once all the Rooms and Channels are added to the project, a communication Device is
operational, and all modules are connected to a supply, then the modules are ready to be
addressed.

The method below describes the most convenient way to address a wireless module.
Alternatively, select “File - Device” and follow the prompts in the “new Device setup
wizard.”

3.1 Addressing a dimmer from the Room editor

To assign Room and Channel numbers to modules, first bring up the “Room editor” tab by
clicking on the relevant Room in the “Room list”. This will show the Channels added to the
Room earlier. Notice how to the right of the Channel description it says “no Device
assigned”.
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For example: to address the living Room wall lights, you will want to press the “2” button as
shown above after putting the module into setup mode. Details of how to put modules
into setup mode are described below.

Select the appropriate module from the list and click "finish.” When “finish” is selected, a
second ident signal is sent to confirm that the correct module has been programmed. The
module should flash the load connected briefly.

3.2 Putting a module with a button into setup mode

To do this, press and hold the button on the
module until the internal LED begins to flash
periodically. When the button is released, it
should continue to flash.

While it is still flashing, press the numbered
button on the software to send an “ident”
command.

At this point, the module will stop flashing,
remain solid for around a second, and then
go out.

NB
When a module is readdressed from default (House:1 Room:4) to any other House and
Room address, the power-up mode will change from “100%” to "Off.” This is only the case
with the modules with set-up buttons. For more information on Power-Up modes, see
Appendix 2 Power-Up Mode.

3.3 Modules with magnet setup

For an older module with a magnet set-up, the process is the
same, except the module is put into setup mode using a magnet.

To put the unit in setup mode, hold a magnet steady against the
side of the module next to the location of its internal LED. When
the magnet is in the correct location, the LED will illuminate. Keep
the magnet in position for a few seconds until the LED starts to
blink periodically, showing the Device is now in setup mode.
Remove the magnet, and the LED should continue to blink.

When a module has been added to the project using the new
Device wizard, it will appear in the Device list in the bottom left
tile. To the right of the Channel name, the module type will now
appear, showing that a Device is assigned to this Channel.
Selecting this will take you to the Device tab for this module.
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4 Setup for Keypads with dip switches (RCM)
Once all the modules have been addressed via the software, the Keypads need to be
paired with the desired Room. On the reverse of the Keypad are two sets of dip-switches
one each for the Room and House address.

Dipswitch Value

1 1

2 2

3 4

4 8

5 16

6 32

7 64

8 128

If the Keypad looks like an RCM but there are no dip-switches fitted, then this is an RNC
and cannot be addressed without Rasoft Pro and an NFC programming tool. See Section 5,
“Setting up an NFC programmable Keypad” for details.

The dip-switches work using a binary number system; if you are unfamiliar with binary, the
switch settings can be read from the software. Right-click on the Room of the Keypad to be
programmed and select “dip-switches”.
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This will bring up a menu indicating how the dip switches need to be set for this Room.

Set the Keypad dip switches as indicated for all switches used in this Room. Repeat this
process for all the different Rooms in the system.

5 Setting up an NFC programmable Keypad
The NFC programmable Keypads are used when multiroom control or additional
programming commands are required outside of the standard local Room on the RCM
Keypad.

5.1 Addressing NFC Keypads (RAMPI)

Unlike the RCM, NFC Devices must be programmed using Rasoft Pro software, a RAMPI or
a HUB is required to do this. First, ensure that the RAMPI is connected to Rasoft Pro in the
communication window (see A1.1 RAMPI).

NFC configurable Devices:

● RNC
● RK-EOS
● RK-MOD
● RK-PIR
● RCI-7M
● RCI-4L
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- To begin the setup process, place the RAMPI on the NFC Device and ensure no
metallic cover plates are fixed to the Device.

- When the Device is correctly positioned, a green LED will flash in the RAMPI, and a
window will pop up in Rasoft Pro.

- Give the Device a suitable name so that it is identifiable in the software.

- Select the local Room for the Device. After the initial setup, the NFC Device will
behave like an RCM with dip switches set to this Room.

NB
It is important to set the Room at this stage. If “Assign later” is selected, then the NFC
Device will not be programmed and will be added as a virtual Device

- Select Finish on the next page to complete the setup. The RAMPI will need to
upload to the NFC Device at this stage.

5.2 Addressing NFC Keypads (HUB)

Similar to the RAMPI, the HUB has built-in NFC programming functionality, which enables
programming NFC Devices. If the HUB has not yet been set up, see A1.2 HUB.

NFC configurable Devices:

● RNC
● RK-EOS
● RK-MOD
● RCI-7M
● RCI-4L
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- To begin the setup process, ensure you are connected to the HUB in the
communication Devices in Rasoft Pro, and that the HUB has been configured.

- Place the NFC Device on the top, middle section of the HUB.

- When the Device is correctly positioned, a green LED will show on the HUB, and a
window will pop up in Rasoft Pro.

- Give the Device a suitable name so that it is identifiable in the software.

- Select the local Room for the Device. After the initial setup, the NFC Device will
behave like an RCM with dip switches set to this Room.

NB
It is important to set the Room at this stage. If “Assign later” is selected, then the NFC
Device will not be programmed and will be added as a virtual Device
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- Select Finish on the next page to complete the setup. The HUB will need to upload
to the NFC Device at this stage.

5.3 Configuring an RNC or RK-EOS

Once set up in Rasoft Pro, the RNC or RK-EOS will use default Rooms.

The button mapping screen for the RNC or RK-EOS can be accessed by selecting it in the
Device list; this will open the Device Editor for the RNC or RK-EOS Device.

To apply a template to an RNC or RK-EOS:

- In the button mapping tab of the Device editor, scroll to the bottom to view the
templates menu.

The templates section will vary depending on the RNC or RK-EOS

- Select the relevant template and click Load Template. This will open a pop-up box;
select yes to overwrite the mapping with the template

- The mappings for this template will now appear in the left tile of the Device editor

- Click “save for upload” at the bottom of the page to upload these setting onto the
RNC or RK-EOS.

- At this point, a progress bar will appear on the screen. Touch the RAMPI on the RNC
or RK-EOS to upload the new settings.
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5.3.1 Button Layout

The RNC and RK-EOS each have inputs that represent the buttons on the Keypad. The
inputs are as follows:
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5.3.2 The Mapping Section

All programmed inputs for the Device must first have a mapping. The purpose of a
mapping is to program a button to perform a specific command. Each input has its own
letter to represent its input; the RK-EOS has 6 inputs, and the RNC has up to 10.

New mappings can be created by selecting a disabled field and selecting the
corresponding input letter in the next column:

Active mappings can be copied or pasted into disabled mappings; this is typically used
when re-using similar functions of an existing mapping to save time, such as a toggle
function.

Mapping right-click options

NB
Ensure only a single letter is used for each mapping, otherwise, the mapping will not
function unless all inputs are pressed at the same time.

5.3.3 Keypad layout

The inputs for the mappings are selected in the Keypad layout section, as well as additional
input options:

Function Description

Send Stop On Release When the button is released, a ‘Stop’
command will be triggered.

Trigger on press Trigger the output command when the
button is pressed.
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Trigger on release Trigger the output command when the
button is released.

5.3.4 Button action

The output actions of the buttons inputs are set up in the button action section, the
following options are available:

Function Description

Room The Room number of the output command.

Channel The Channel number of the output
command, can be All Channels or a single
Channel.

Disable map When enabled, the button input will have
no output command.

Scene If a Scene is being triggered, select a Scene
between 1-16.

Fade-Up/Fade-Down Commonly used to manually dim lighting
up and down, as well as the
opening/closing of blinds.

NB
‘Send Stop on Release’ should also be
checked when using this option.

Motor Stop Used to stop 3rd party motors that are
configured within the HUB.

Ident This option is not recommended, as the
command will make a load flash
momentarily and provides no practical
function for daily use.

Toggle The Toggle function will alternate between
two commands, either a Level command
and Off, or a Scene command and Off.

NB
Do not map more than one Toggle to a
single button on the inputs; this will result
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in sporadic switching due to toggles
getting out of sync.

Level Sets the lighting Level to a percentage of
brightness between 0-100%.

Tunable White Set the temperature output.

Macro Trigger an internal Macro on the Device;
this is not the same as triggering a Macro
on a HUB.

NB
Macros can be created on the ‘Macro’ tab
above the button configuration.

5.4 Configuring an RK-MOD

If the RK-MOD has not been set up, see 5.2 Addressing NFC Keypads (HUB).

5.4.1 Button Layout

The RK-MOD has 12 inputs and can be configured in many different ways, depending on
the buttons used.

When multiple inputs are used, the next available input letter is used, which can be seen in
the example below:

Wireless Module Setup Guide Version 3.5.0



D, E, and F inputs combined for an OFF button.

The button mapping screen for the RK-MOD can be accessed by selecting it in the Device
list in Rasoft Pro.

5.4.2 Templates

A range of existing templates may be used if the button configuration matches; to load a
template, select the template required, then select ‘Load Template’. Once the template has
been loaded, it must be uploaded to the RK-MOD. Do so by placing the RK-MOD on the
HUB or RAMPI and selecting ‘Save and Upload’.
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5.4.3 The Mapping section

All inputs for the Device must first have a mapping. The purpose of a mapping is to
program an input to perform a specific command. Each input has its own letter to
represent its input; the RCI-7M has up to 7 inputs.

New mappings can be created by selecting a disabled field and selecting the
corresponding input letter in the next column.
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Active mappings can be copied or pasted into disabled mappings; this is typically used
when re-using similar functions of an existing mapping to save time such as a toggle
function.

Mapping right-click options

5.4.4 Keypad layout

The inputs for the mappings are selected in the Keypad layout section, as well as additional
input options:

Function Description

Send Stop On Release When the made contact is released, a
‘Stop’ command will be triggered.

Trigger on press Trigger the output command when the
momentary switching makes contact
between its input and common.

Trigger on release Trigger the output command when the
momentary switch breaks contact
between its input and common
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5.4.5 Button action

The output actions of the button inputs are set up in the button action section, The
following options are available:

Function Description

Room The Room number of the output command.

Channel The Channel number of the output
command, can be All Channels or a single
Channel.

Disable map When enabled, the button input will have
no output command.

Scene If a Scene is being triggered, select a Scene
between 1-16.

Fade-Up/Fade-Down Commonly used to manually dim lighting
up and down, as well as the
Opening/Closing of Blinds.

NB
‘Send Stop on Release’ should also be
checked when using this option.

Motor Stop Used to stop 3rd party motors that are
configured within the HUB.

Ident This option is not recommended, as the
command will make a load flash
momentarily and provides no practical
function for daily use.

Toggle The Toggle function will alternate between
two commands, either a Level command
and Off, or a Scene command and Off.

NB
Do not map more than one Toggle to a
single button on the inputs; this will result
in sporadic switching due to toggles
getting out of sync.
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Level Sets the lighting Level to a percentage of
brightness between 0-100%.

Tunable White Set the temperature output.

Macro Trigger an internal Macro on the Device;
this is not the same as triggering a Macro
on a HUB.

NB
Macros can be created on the ‘Macro’ tab
above the button configuration.

5.4.6 Keypad Layout Editor

The RK-MOD has fully customisable button layouts, which can be configured in the
RK-MOD Device menu.

The Keypad Layout Editor is found by selecting the tab above the mappings window:

- Existing templates can be loaded into the mapping page:

- Select the layout name
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- Select ‘Select Layout’

- The layout will now be loaded on the ‘Button Config (Mapping)’ page.

5.5 Configuring an RCI-4L

If the RCI-4L has not yet been set up, see 5.2 Addressing NFC Keypads (HUB).

5.5.1 Opening the Device Editor

The input mapping screen for the RCI-4L can be accessed by selecting it in the Device list;
this will open the Device Editor for the RCI-4L.
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5.5.2 Wiring and Programming example

There are four latched inputs on the RCI-4L, Each input has an ‘A’ contact and a ‘B’ contact.

In the example below, input A is used to Trigger Scene 1 A-1, and A-2 is used to Trigger
Scene Off.

NB
Up to 4 latching switches can be used per RCI-4L.
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5.5.3 The Mapping section

All inputs for the Device must first have a mapping. The purpose of a mapping is to
program an input to perform a specific command. Each input has its own letter to
represent its input; the RCI-7M has up to 7 inputs.

New mappings can be created by selecting a disabled field and selecting the
corresponding input letter in the next column.
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Active mappings can be copied or pasted into disabled mappings; this is typically used
when re-using similar functions of an existing mapping to save time such as a toggle
function.

Mapping right-click options

5.5.4 Inputs

The inputs for the mappings are selected in the Keypad layout section, as well as additional
input options:

Function Description

Send Stop On Release When the made contact is released, a
‘Stop’ command will be triggered.

Trigger on press Trigger the output command when the
momentary switching makes contact
between its input and common.

Trigger on release Trigger the output command when the
momentary switch breaks contact
between its input and common
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5.5.5 Button action

The output actions of the inputs are set up in the button action section. The following
options are available:

Function Description

Room The Room number of the output command.

Channel The Channel number of the output
command, can be All Channels or a single
Channel.

Disable map When enabled, the button input will have
no output command.

Scene If a Scene is being triggered, select a Scene
between 1-16.

Fade-Up/Fade-Down Commonly used to manually dim lighting
up and down, as well as the
Opening/Closing of Blinds.

NB
‘Send Stop on Release’ should also be
checked when using this option.

Motor Stop Used to stop 3rd party motors that are
configured within the HUB.

Ident This option is not recommended, as the
command will make a load flash
momentarily and provides no practical
function for daily use.

Toggle The Toggle function will alternate between
two commands, either a Level command
and Off, or a Scene command and Off.

NB
Do not map more than one Toggle to a
single button on the inputs; this will result
in sporadic switching due to toggles
getting out of sync.
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Level Sets the lighting Level to a percentage of
brightness between 0-100%.

Tunable White Set the temperature output.

Macro Trigger an internal Macro on the Device;
this is not the same as triggering a Macro
on a HUB.

NB
Macros can be created on the ‘Macro’ tab
above the button configuration.

5.6 Configuring an RCI-7M

If the RCI-7M has not yet been set up, see 5.2 Setting up NFC Keypads (HUB).

5.6.1 Wiring and Programming Example

The RCI-7M is an interface for momentary switches, there are 7 inputs which can be
mapped to Trigger a command on press and on release.

The input mapping screen for the RCI-7M can be accessed by selecting it in the Device list;
this will open the Device Editor for the RCI-7M.
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5.6.2 The Mapping Section

All programmed inputs for the Device must first have a mapping. The purpose of a
mapping is to program an input to perform a specific command. Each input has its own
letter to represent its input; the RCI7M has up to 7 inputs.

New mappings can be created by selecting a disabled field and selecting the
corresponding input letter in the next column.

Wireless Module Setup Guide Version 3.5.0



Active mappings can be copied or pasted into disabled mappings; this is typically used
when re-using similar functions of an existing mapping to save time such as a toggle
function.

Mapping right-click options

2.6.3 Inputs

The inputs for the mappings are selected in the Inputs section, as well as additional input
options:

Function Description

Send Stop On Release When the switch is released, a ‘Stop’
command will be triggered.

Trigger on press Trigger the output command when the
switch is pressed.

Trigger on release Trigger the output command when the
switch is released.

2.6.4 Button action

The output actions of the button inputs are set up in the button action section, the
following options are available

Function Description

Room The Room number of the output command.

Channel The Channel number of the output
command can be All Channels or a single
Channel.

Disable map When enabled, the button input will have
no output command.

Scene If a Scene is being triggered, select a Scene
between 1-16.
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Fade-Up/Fade-Down Commonly used to manually dim lighting
up and down, as well as the
Opening/Closing of Blinds.

NB
‘Send Stop on Release’ should also be
checked when using this option.

Motor Stop Used to stop 3rd party motors that are
configured within the HUB.

Ident This option is not recommended, as the
command will make a load flash
momentarily and provides no practical
function for daily use.

Toggle The Toggle function will alternate between
two commands, either a Level command
and Off, or a Scene command and Off.

NB
Do not map more than one Toggle to a
single button on the inputs; this will result
in sporadic switching due to toggles
getting out of sync.

Level Sets the lighting Level to a percentage of
brightness between 0-100%.

Tunable White Set the temperature output.

Macro Trigger an internal Macro on the Device;
this is not the same as triggering a Macro
on a HUB.

NB
Macros can be created on the ‘Macro’ tab
above the button configuration.

6 Scene Setting Rooms
With all the circuits addressed and Keypads set up, the system should be fully functioning
on default Scenes.

The default Scene percentages are:
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Scene Percentage

Scene 1 100%

Scene 2 75%

Scene 3 50%

Scene 4 25%

6.1 How to Set a Scene in a Room

A Scene can be any percentage between 0-100%, once a Scene is saved, it can be recalled
using a ‘Scene’ command.

In Rasoft Pro, click on the Room to bring up the Room editor tab

Select a Room (the selected Room button will outline blue)

Move the slider for each Channel to the desired light Level

Press “Store Scene”
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Scenes can be renamed by editing the text fields.

To add additional Scenes to set, select ‘Add Scene’

6.2 Advanced Scene Setting Features:

To access additional Scene setting features, right-click on the “Store Scene” button to make
a drop-down menu appear:
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These extra options allow Rooms to be transmitted without the need to individually reset
every slider for every Channel. This is particularly useful when a dimmer has been swapped
and the Rooms need to be reuploaded to match those in the removed dimmer.

Send Store Command:

Performs the same function as pressing the “Store Scene” button normally (left clicking).

Transmit all sliders:

Re-transmits all the current slider Levels for the selected Room.

Write Scene “1” Level Data:

Uploads all Levels and stores the currently selected Room (in this case Room 1)

Write All Scenes Level Data:

Re-uploads all Room information for the Room to all dimmers addressed to it.

Appendix 1 Setting up communication Devices:

A1.1 RAMPI

To connect to the RAMPI:

- Plug the module into the USB port on your computer, and Rasoft Pro should find the
Device.

- Right-click on “RAMPI” in the communications box and
select ‘Connect/Disconnect’.

- If the “RAMPI” icon does not appear, click refresh below
the communications box.
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A1.2 HUB

A1.2.1 Connections

- Connect the HUB to an accessible network via the supplied Ethernet cable.

- Connect the power supply.

- Allow 2-3 minutes for the HUB to start up; there will be a blue light on the top when
the HUB has finished starting up.

- Select ‘Refresh’ on the communications Devices

- Right-click the HUB in communication Devices and select ‘Connect/Disconnect’

- A green tick will verify that the connection has been successful.

NB
The House number for the project file and the House number on the HUB must be the
same, if there is a mismatch, there will be a warning in Rasoft Pro when connecting to the
HUB.

A1.2.2 Configuration

- Right-click the HUB in the communication Devices

- Select ‘Open in Browser’

- A web browser will open the HUB web pages.

- If this is the first time opening the HUB, the Setup Wizard will begin, Select ‘Next’
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- Choose a password and select ‘Next’.

- Choose a name for the HUB, as well as the House address matching the Project in
Rasoft Pro. Select ‘Next’.

- Select ‘Finish’
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The HUB basic setup is complete and will now control Wireless Devices in range via Rasoft
Pro. For the HUB to be configured for App control, the Room and Channel information
must be uploaded to the HUB via Rasoft Pro.

As a final check, it is advisable to disconnect and reconnect to the HUB:

If no pop-up box appears, then the HUB House number and Project file House number are
the same.

WARNING
If a pop-up box appears with a warning about the House number, click "Cancel.” Do not
continue programming this means there is a conflict between the Project File House
number and the House number on the HUB.

A1.2.3 Adding the HUB/Bridge as a Device in Rasoft Pro

Once the HUB has been configured in the web pages, it needs to be added as a Device to
Rasoft Pro to upload the Room and Room information for App control.

- Connect to the HUB by double-clicking it in the communication Devices; a green
tick will show to verify the connection has been successful.

- Go to ‘File > New Device’
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- Select ‘HUB/Bridge’ and ‘Next’

- The IP address of the HUB will appear in the next window; highlight it and select
‘Finish’

- The HUB has now been added as a Device in Rasoft Pro.

Once the HUB has been added as a Device, it will require further setup for App control, see
A5 Uploading to a HUB/Bridge and App setup for further information.
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Appendix 2 Power-Up Mode
The Power-Up mode determines the Level or Scene a Device will output when it is initially
switched on at the supply.

NB
The default Power-Up mode is 100%

A2.1 Setting A Global Power-Up Mode

It is possible to set the Power-Up Modes “globally” for the entire System. To access this
menu:

- Select “Tools” > “Global Power Up”.

- Select the Power-Up Mode required.

- For systems which are left empty for long periods of time, ‘Off’ is a recommended
Power-Up Mode.

- Systems that are constantly in use, ‘Last Scene’ is a recommended Power-Up Mode.

Wireless Module Setup Guide Version 3.5.0



Appendix 3 Fade rates
Using Rasoft Pro, it is possible to edit the rate at which Rako modules Fade between
Lighting Levels.

A3.1 Change the Fade Rate for a Room

- Open the Room editor, right-click Room Devices and select ‘Fade Rates’.

NB
This will set Fade Rates for every Device in the Room. To set Fade Rates for a specific
Device, select it in the Device List and click on the Fade Rates tab in the Device editor.

The Fade Rate menu will be displayed as below.
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Two types of Fade Rates can be adjusted:

Scene controls

The rate at which Circuits move between Rooms (including Off).

Fader controls

will change the rate at which Circuits dim up or down when the Fade buttons (raise/lower)
are used.

NB
Setting all of the fader controls to max speed will make it almost impossible to dim the
lights from the Fade Up/Fade Down buttons.

A3.2 Change the Fade Rate for a Channel

When a specific Room requires a change in Fade Rate, it can be adjusted in the Room
Editor.

- Go to the Room Editor, and right click the assigned Device, select ‘Go to (Device)’

- Select the ‘Fade Rate’ tab
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Appendix 4 Uploading to a HUB/Bridge and App setup
After a system has had all Rooms, Channels and Devices added, the information needs to
be uploaded to the HUB in order to control the System via the App and the web pages.

- Select the HUB in the Device List

- Select ‘Smartphone/Web Data’

- Select ‘Save & Upload Room Data to HUB/Bridge’

The Room, Channel and Scene information is now uploaded to the HUB, and can
be accessed via the Rako App or via the HUB webpages.

A4.1 Room Mode

The App will display a 4 Scenes + Off arrangement by default, there are additional
options depending on the control panels used and the number of Scenes required
in the App.

To change the Room Mode:

- In the Smartphone/Web Data section, select the ‘Mode’ drop down menu for
the relevant Room.
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- Select the required option for each Room.

- Select ‘Save & Upload Room Data to HUB/Bridge’

A4.2 Room Type

If a Room is not for dimmable lighting, the Type can be changed.

- In the ‘Smartphone / Web Data’ menu, select the ‘Type’ drop-down menu for
each Room to specify its Type.

- Once the Room Types have been set, select ‘Save & Upload Room Data to
HUB/Bridge’.
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A4.3 Channel Type

Similar to Room Type, individual Channels can be set to different circuit types, the
most common use is setting a non-dimmable circuit to ‘Switch’ which will remove
dimming options on the App and instead give an ‘On/Off’ option.

To set a Channel Type:

- In the Smartphone/Web Data section, select the Room to highlight it and
select the ‘Type’ drop-down menu for the relevant Channel.

- Once the Type has been selected for all of the relevant Channels, select ‘Save
& Upload Room Data to HUB/Bridge’
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A4.4 Smartphone / Web Data Options

Enable

When the box is ticked, the Room will appear in the App, Rooms which are not intended
for direct control via the App should be unticked.

Title

The names of the Rooms on the left side menu will be displayed here, the names in the list
will appear in the App.

Type

Changes the options available for the Channel in the App, for example, if a circuit is
changed to a ‘Switch’, in the App an ‘On/Off’ layout will be shown rather than a Slider.

Mode

Depending on the requirements of the Room on the App, the Mode can be set to show
different button configurations, the correct configuration will depend on the individual
requirements as well as the Keypads used.

Room Order

The order of the Rooms can be adjusted by selecting the header to sort Numerically or
Alphabetically, as well as dragging the Rooms up/down to create a customisable order.
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